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ABOUT THE COLONEL'SBEQUEST

The COLONEL’S BEQUEST is different from many
adventure games. It can best be described as an
interactive play in 8 acts. You will play the entire game
in one location, on an isolated island in a bayou. Events
can take place throughout that locale at any time during
the game, and they may occur whether you are present
or not. -

At the end of each Act, a clock will appear on your
screen and strike the hour. It will also appear at other
intervals during the game. Take note of the events
which cause this to happen, and your location at the
time it occurs, as this will help you to keep track of your
progress. Being in the right place at the right time can
be invaluable.

Also, if you have thoroughly explored a room, don’t
assume that the next time you visit the room things will
be the same. While you are exploring another area,
someone else may enter the room and leave a valuable
clue for you to find! :
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CAST OF CHARACTERS

Laura Bow

Laura is a 20 year old
ournalism major at
ulane University in
New Orleans. A 1920°s
ingenue, she’s studious
¥ and down to earth,
energetic and
courageous, She’s known
for her inquisitive nature,
ﬁrot[ably acquired from
er father, a detective on
the New Orleans Police
force.

Ethel Prune

Lillian’s mother and the
Colonel’s younger sister,
Ethel is known Tor her
whimpery, whiny nature.
You can usually catch
her in a rather tipsy state,
and she gives the
impression of being
quite helpless.

Colonel Henri Dijon

Henri Dijon is a gruff old
southern-style colonel.
He’s wealthy, eccentric
and reclusive, He lives
alone except for his
servants; Jeeves, Celie
and Fifi, and his pets. He
was wounded while
serving with distinction
in the Spanish-American
war,

Gertrude Dijon

Gertie is the widow of the
Colonel’s younger
brother. She’s known as
money grubbing,
snobbish and bossy. She
has a fondness for
Jjewelry. . . especially
pearls.

Lillian Prune

Lillian is Laura’s college
classmate and the
Colonel’s niece. Her
personality can be
described as extroverted
and rebellious. She
drinks, smokes and dates
several young men. She
dresses 1n the style of the
1920°s flapper.

Gloria Swansong

Gertie's daughter and the
Colonel’s niece. An
aspiring actress, Gloria
enjoys the LFl_amm‘ous
Hollywood life-style.
She’s a beautiful

latinum blonde, and
oves money, jewelry
and rich boyfriends.




Rudolph Dijon

Rudy is Gertrude’s son,
Gloria’s brother and the
Colonel’s nephew. He

ives the impression of
Eeing a little too slick.
Rudy is known as a
gambler, a womanizer
and a lush. They say he's
never woerked an honest
day in his life.

Jeeves

Jeeves is the Colonel’s
tall, silent butler. Very
imposing and solemn,
he s not terribly friendly
or helpful. What is he
really after?

Clarence Sparrow

Clarence is the Colonel’s
altorney. He manages all
of the Colonel’s business
affairs and accounts. He
seems rather sneaky, and
it is said that he lusts after
the Colonel’s money.

Fifi

Fifi is the Colonel’s sexy
French maid. It is
rumored that she and the
Colonel are involved in a
relationship of a
somewhat more than
domestic nature. Most of
the family are of the
opinion that Iifi i1s using
the Colonel (o get at his
money.

she dabb

Dr. Wilbur C. Feels

Dr. Feels is the Colonel’s
long time personal
physician. He is known
for his lecherous ways,
and his questionable
medical practices.

Celie

Celie is the Colonel's
cook. She 1s quite
superstitious and
somewhat reserved, but
she can be friendly and
helpful if approached
cautinusl{v. t is said that
es in voodoo.

———




Beauregard

Beauregard is the
Colonel’s dog. A lazy old
bloodhound, %le can be
observed lying near his
doghouse most of the
time.

Blaze

Blaze is the Colonel’s old
horse. Like the Colonel,
he’s a veteran of the
Spanish-American war,
but now rarely leaves the
comfort of his stable.

Polly

The Colonel’s parrot sits
on his perch in the parlor.
He talks when he’s in the
mood, or when properly
motivated.




fACTI

- . 'S(,ENF I ’ .
Wi Thaa Al Scene: Day Campns cvmmon.s‘, Talane

Ustudiing to do.t " ol 2 - “University in New Orleans, Louisiana in the -
e . year 1925, during a class break. LAbRA '
BOW sits upon a bench, center stage, .
reading a textbook. LIL LIAN PRUI NF
stands near LAURA also center s!age

LILLIAN Lama I ve leSt recelved an 1nv1tat10n to: vmt my Uncle Hexm s ebtdte for a fannly S
- reunion Ihls weekend . s , i _ .

AURA (seemmgh' absof bea‘ m her smd:es) Thdt s.ounds mce L[l Y()u mum be se exelted

T LILLI AN: Yes; I suppose T am. (fooh 9Ieghrfy pazded then.her fa(e ma’denf} ffghrs up) _
‘Maybe you’d like . to come along!. U ncle Henri’s mansion is on.a private isl and l"iEhl in the - j H
mldd]e of the ba\eou Someone llke youw should find. II}‘(JSE.’H(HUIg' o e

2 _-.'LA[ RA Iden tknow L1ll|dn Ire(ﬂly should stucly

-'LILLIAN Oh come on. Laura It Il be fur11
(pause} o

'_"."LALRA (iookmq up anddosmg }wr boo!u) WeII Isuppose it won thurt At any Iﬁle 11 >hould' Heat
- be more fun than rewewmg tor ‘my. blology exam, . _ ; e

' .-L]LLIAN Oh we re. <Tmng m hdvc \ueh a t]mc You wun trcgrct |1 Ldurdf

QCFNE H

' Scene: Night: A dark and mtaty bayau ey
. LAURA and LILLIAN skim through rke ’
" gloom aboard a small skiff. A tall and
. ~silent BLACK MAN pilots them. The -
" silence is broken occasionally by the eerie
- cry of a night bird. Finally the form of a -
_-grand house becomes discernible thmugh ;
2. the dense trees. The skiff comes to ahalt
. . -at @ small-dock, and the girls disembark.
- Without a word, the BLACK MAN furns .
.- the boat around and is quickly lost in'the
. dark-mists of the bayou. LAURA watches (N
Yod untzl s‘he can no i(mgerwe hrm oa e TR




SCENE III

"Scene: An niandm the. swamp, on the ;

unkempt grounds of Colonel Dijon’s esrate ;A

. An ominous looking, run down old mansion

“.is visible in the bac graund LAURA and

- LILLIAN are walking toward the house. :
 LAURA looks around conanuausty, as if she

. expects somerkmg to jump out of the e

shadaws Ske Jamps wken LILLIAN speaks ;

T R

LILLIAN Well what doyou thmk Laura?':_

LAURA: (m’mchev her .:hesr then seems to'. 5

* catch her br earh) It’s not cxa.ct y th[l

_'expcu,c,d (Ermkx amw]d) hut it Iooks Jmerestmg all right (?hnm S‘J
" (Pause as the qu Is, wad’k in sifence ﬁu a momem} :

~'LILLIAN: Uncle Henrl was a colone] in the Spdmsh Ameucan war, you know In fat,t he sm‘{“
- prefers to be Ca_ led _(.olonel Dlron I don ILEIH hlm that though --to'me he s m\« dear- old ' '

Uncle llcnn

; ,([ IL I IAN prmses Snoks msrﬁd as (}muqh wcah’mgforzd memor:cs}

, ; LILLIA\T He’s a pu:uhar old bird, ihnu“‘h He (,ovets hls prwacy and detesrs bemg bothsred &

That’s why he bought this place (gmmw«' about them). When Fwas a little girl, he-would -

~_invite me to visit him here in the summers. Looking back, it seems that I was the only one in
“the family that he really cared about. That’s why I'm ‘puzzled ‘about this ‘fam1]) n,umon I
never would ha\re cxpu,u,d a fdml y L_dthermg at Uncle Henn Se A bl .

"fSCEerv

_S(,ene The largefmnrporch of the Duon

“mansion. LILLIAN and LAURA stand

_center stage before an immense door. On:the
! door are; two huge door imnckere i o

: LILLIAN (Jea( het fm ()ue ()frhp dr)m _
: km)(km 3, g:gg?es‘) Kmda {,r"{,py isn’ Lll‘? e

L (LILLIAN brings the door knvcker a'own
with a-loud BANG! and again BANG! A

— “short:pause, then-the door creaks oper: 0
ATk .-?evaJEEVES rhe ra:‘! gaw:r bur!e; ) i

k- ILE\' Eb Lm a deep m:pr)\mg! VOIc E’) chc%%k‘f’
(L AU RA eapes at the forrmdabi'e bmiw) el Y
5 --LILLIAN (\mu'me) Jeeves, it’s me, Lllhan don tyou 1emember?

.JFFV ES: Ohhh yesss “Well, evewone else- haﬂ; arrwed and they I‘G assemb mg in the dimng-- : i
: mum Plea\e mme in. and JOl]‘l them ; i, L



(JEE\f E% steps. as;a’e and gesrw es jm rhe rwo gm’s to emer LAURA and LILLIAN pr’()c eed
mm rhe house . : : _ _ ; :

SCENE V ,

- Seene: The dining room of the Dgon ;
. mansion. A fire is ablaze in the fireplace, =
upstage center. An enormous dining table,
- splendidly set, occupies center stage
41  Seated at the mb!e are LAURA; ¥

.- LILLIAN; ETHEL PRUNE, IHJ IAN’S S
“. mother; (“‘FRTRUDE DUON widow vf i
- the COLONEL'’S late brother; GLORIA
- SWANSONG, GERTRUDE’S daughter

and the COLONEL’S niece; RUDOLPH.

" brother and the COLONEL’S rigphc»,

:. CLARENCE SPARROW, the

e (Fme: COLONFL DIION ; ina wken!nhau Hc is bemg aza’ed by HFI hw ?e,n b!(mde ma:d
i _,She pw ks hrm ar rhe head of the Irmg e‘able J A

T (,OL(}NFL DIJ()N (rmdls ter se!y, and. speaks ina gre;fjfr,orc e-) i i glad to see that you re all
© here I’ m sure y(}u re: dI! w(mdumg wh\e I \:L ask e _

: -‘:-'_'(pame ds DIUON dea:sku rhr oar)

5 -L.dyou

] COLONEL DI ]OI\ As: you know, [ﬁrn a uery weatthv man. Unfonunately I belleue my end': S
i3 near and sol have deaded ro bequeath my many mﬂllons to each of )ou T d R

.(pauw a?DIJON appems 10 noncel AURAfm rhqu st nmp)- &) : R
g COLONEL DIJOI\ Who are- you dear‘? ' S

i ."LAURA (rmwm!}) Oh lb-.,g your pardon ‘;]I‘ my name is. L aura Bow -- 'm |u<;t a. trlend ot #
- Lillian’s. ‘Would you like me, to leave the room wh]lf: you talk about tlus’ T 0

--_LOL()NEL Dl.}()l\ No 1o, just sit. ‘where \«ou are,I'm nearlv hmshed \Iow where was [2°°
. Oh, yes. AHEM!:As L was sdying, each of you here, except for Miss . . . ah, Bow.is it? Yes, ~
- well you'll'all inherit EQUALLY upon my demise. If any of you should explre before I do.
S then your share ml be. dmcled equallv amonz the suwwmg parties. =

bl (pause as DUON smw»,s h:s gues:s apparemi» ie!zmg hts wom’s wnA in. The gufsrs i'oak ar
. one anaﬂfff mspu wm.-’v) i o : ; : i

e 'COLONEL DI JON: I'm tired FJf] He p me to'my room (1’00&5 agam at rhe am’mbled T
r'-..guesrs) If you’il all excuse me; I'm going to retm, fur 1hp wcmng I mll sae you aH in the g
_mnrnmg Hdve a p]easantmghr , Gl G . G

$ (DUOI\ \Igna!\ FIF] W hn turns hrm amand amf W hee!s hsmﬁ om n’w mom The Qroup sn‘s m o
. sxfenm aﬂn’l DHONIR wme ) e S A : .

. DIJON, GERTRUDE’S son, GLORIA’ e ]

R L Ty : ; COLONEL’S aftorney; and DR, WILBUR - .
-C I LLL.S me C()L() ?\’LL’S long ﬂme persarmf ph}sman During dinnef, LAURA is introdutced
* ‘to the other guests. They dare largely :mpleamut and. bu‘ker amongst themse!ves rhraughout the it
- -meal. At Iast descert is s‘erved it : firats ;




. mdke )ourself at home dnd feel free Io explore‘

] '“'.'-'-'(JERTRUDE Can }ou ba,ln,wthdt”? : .y
"‘.__RUDY Theodgoat ‘_ el _ ekt
£ (‘LORIA I’m 9urpr1sed he didn’ ttrv to take tt w1th hlm he s such an old Nklnﬂ]]‘lﬂ' :

RUDY I don t thmk YOU deecrvc any money"

e (:LORIA Speak ior )oursdﬂ P
: : _;{LLARLNLE, How much do vou lhmk hc, s;:ol‘? ' _. 0
: W ILBUR We ll I know whatl m gomg to,do Wlth MY %halcf _
- CLARENCE YOUR SHARI:‘” 1 bet the. old codger outln es YOU1
i .;'GERTRUDF 1 wonder how ;SIC!\ BEAST. o7 ey :
. y 4 ET HhL ‘Do yOu thmk he’ll go ‘;oon" :

: _'-LILLIAN (srana‘mg abmprfy) I’\«e had enough of thm' Laura and L w1!l rum. m nur ruom
'now ; PegEi e T ) ;

L Le)m[ AURA mm’ LILLIAN)

SCEN]L Vl

: “Scenie: Guest room sﬁ&red by LILLIAN
. and’ LAURA. Two'beds occupy upstage .

- sits downistage center and near it an’
" armchair. A large portrait of COLONE L
" "DIJON hangs upon the wail above the

. fireplace, upstage center. LILLIAN opens -
" her suitcase and rummages th‘mugk i! :
‘_LA DRA mrvey:s the mom

: LAURA Thank )nu L1I lmdy dO_]USI that

> (LILLIAN ﬂnum es out (yf.fhe Foom, feavmg Law‘a a?one LALRA warzder‘: around rfze mom- A
for ashort time, etamumi‘g Cfr)é,et‘s a’:au vers and var :mm abjecn !heﬁ 1em‘mes out mw rhe i
: eriormom mam:ou ) LR N M - - I

afrald she mdy bem a Ilttle ever her head Let’s jﬂlll her now, hefqre the rcal fun :. i
o begms ‘May be we’ libei in time to be of some assistance to- her as she altemptz, tu
__solvc thc myqtery of A THE COLONEL’S BEQUEST' Y ; .

. right and downstage right. A small. coac_h 5

:'_ [ ILLIAN Wlll )()u excuse mc Ldura?-f; hG
I'm rromg to freshen up a blt Please ok 2 &
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HOW TO READ THIS MANUAL

Throughout this manual we will be using the following ways of representing information:

MENU COMMANDS will be capitalized.
Example: SAVE, RESTORE, QUIT, PAUSE

Typed commands will appear as bold type.
Example: ‘type: ask lillian about ethel’
‘type: cd \sierra’

Portions of the command line not meant to be typed will not appear in bold type. For
example, in the line ‘type: ed \sierra’, ‘type:’ should not be typed.

[Example text] and [Keystrokes] will appear in brackets setting them off from the
surrounding text. The brackets ([]) are not keystrokes and should not be typed.
Example: [object], [character], [Spacebar], [Tab], [PageUp]

Two or more keys that should be pressed at the same time will be separated by a hyphen
(-). This hyphen is not a keystroke, and should not be typed.
Example: ‘Press [Ctrl-I] to view your inventory.’

If a space appears between parts of a command, it is meant to be typed.

Example: t)g:e cd \sierra’ (the space between cd and ‘sierra should be typed as part of
the comman

The term “diskette’ is used to refer to either 5.25" or 3.5" data storage disks.

ALL SYSTEMS
PLEASE NOTE: It is important that you view the README file on your game disk as it
may contain important information and instructions that were not available at the time
the documentation and other materials for this game were printed. Failure to review the
README file before installing the program may result in unexpected consequences
during the installation and/or running of the program,

MS-DOS README INSTRUCTIONS
To view the README file from DOS, type: readme. If the file is longer than one screen, Use
[Page Upl/[Page Down] to scroll through the file one screen at a time.

ATARI ST README INSTRUCTIONS
To view the README file from the desktop, double-click on the README.DOC icon. You
will see a message box with choices for SHOW, PRINT, and CANCEL. Choose SHOW to

e o s




view the file one screen at a time. Press [ENTER] to see the next screen. Choose PRINT to
print the file, Choose CANCEL to escape the message box.

AMIGA README INSTRUCTIONS
Insert WorkBench disk into drive DFO: and turn on your system. Double-click on the CLI icon.

Users with one drive: Copy the ‘type’ command into your RAM disk. See your Amiga
owner’s manual for instructions. Insert game disk 1. Type: type readme.

Users with more than one drive: Insert WorkBench in drive DF0:. Insert game disk 1 in
drive DF1:. Type cd DF1:, Type: type readme.

GETTING STARTED: DISKETTE DRIVES

It is always advisable to make back-up copies of your master program diskettes to increase the
life of the masters and guard against accidents. Follow your computer’s instructions to make
copies of all game diskettes.

Even if you will be playing from a hard disk, you may also want to format a blank disk for
saving games. Follow your computer’s instructions to format a blank diskette and keep it
handy for saving your game as you play. For some helpful tips on saving games, see the
‘Saving Your Game’ (Page 9) and ‘Interacting with The Colonel’s Bequest' (Page 9) sections
of this manual.

When installing your program, you may be prompted to insert a ‘Drivers’ disk. If you receive
this prompt, please examine your disks and insert the disk marked ‘Drivers’ and press
[ENTER], so that the appropriate drivers will be loaded. Some games do not include a separate
‘Drivers’ disk.

MS-DOS
INSTALL THE GAME

Place the back-up copy you have made of disk 1 into your diskette drive. Type the letter of the
drive you have placed the diskette into followed by a colon (for example: a:), and press
[ENTER]. Type: install and press [ENTER].

Answer the onscreen questions using the up and down [Arrow] keys to highlight your
selections, then press [ENTER] to select. You will be asked if you wish to install the game on
your hard disk. If you do not wish the game to be installed on your hard disk, press [ESC] to
skip this step. If you want to install the game on your hard disk, enter the letter designation of
your hard disk (usually C) and follow the prompts.

Please note: Even if you install to a hard disk, the install procedure will write a file
named RESOURCE.CFG to disk 1. For the installation to be completed correctly, DISK
1 MUST NOT BE WRITE PROTECTED. No other files on disk 1 are written or changed
by the install command.




LOADING INSTRUCTIONS
After completing the INSTALL procedure:

From diskettes:
1. Place Disk 1 into the A drive.

2. Type: a: and press [ENTER].
3. Type: sierra and press [ENTER].

From hard disk:

1. From your root directory, type: ed \sierra and press [ENTER].

2. Type: ¢b and press [ENTER].

SAVING GAMES TO DISKETTES

PLEASE NOTE: If you’re playing from diskettes, you must have a separate formatted
diskette ready before you can save a game. Since each diskette can only hold a limited
number of games, we recommend that you have more than one formatted in order to
assure adequate space for save game storage.

1.Choose SAVE GAME from the File menu,or press the [['5] key. The Save Game menu
will appear.

2.Use your [Tab] key to choose CHANGE DIRECTORY. Backspace or press [Ctrl-C] to
clear the command line.

3. Type the letter of the drive you are using for saved games, followed by a colon
(Example: a:) and press [ENTER].

4. Type the name of your saved game and press [ENTER] to complete the SAVE GAME
procedure. If your disk for saving games is full, you may reformat it (this will erase the
saved games on the disk) and use it over, or use another formatted blank disk.

SAVING GAMES TO HARD DISK

If you choose to save games to the hard disk, the program will automatically try to save to the
game’s own directory. If you run out of space for saving games, try one of the following
alternatives:

1. Save additional games to a diskette.

2. Save games to a different directory by using your [Tab] key to choose CHANGE
DIRECTORY from the Save Game menu (inside the game).



3. Delete the saved games and the save game directory from your hard disk by following
DOS instructions (outside the game). The program will create a new directory for your
games.

4. Create a new hard disk directory from DOS, using DOS instructions.

ATARI ST

LOADING INSTRUCTIONS

Note:

If you are using an Atari 520 ST without memory expansion, turn off all desk

accessories (rename .ACC extension .ACX) before running your Sierra game.

1. If you are playing the game from diskettes: place Disk 1 in drive A, open the disk by
double-clicking on its icon. Start the game by double-clicking on SIERRA.PRG.

2. If you are playing the game from a hard disk: open the disk by double-clicking on its
icon, then open the game folder by double-clicking on the game folder icon. Start the
game by double-clicking on SIERRA.PRG.

HARD DISK INSTALLATION

Please note: More than 512K of memory is needed to run Sierra games on your Atari ST hard

disk.

1. Open the hard disk by double-clicking on its icon.

2. Create a game folder by choosing NEW FOLDER... from the File menu. Open the
new folder by double-clicking on its icon.

3. Place Disk 1 in drive A;.

4. Copy the game disk into the new game folder by dragging the drive A: icon into the
window you opened in Step 3.

5. Repeat steps 3 and 4 for each of the other game disks.

6. Put the master disks away in a safe place.

CHOOSE A MUSIC DEVICE (Optional)

Your Sierra game is initially set up to play music and sounds through the Atari ST’s internal
speaker. If you have one of the supported MIDI synthesizers, you may run the MUSIC
program to have the game play music through the synthesizer.

1. Open the game disk/folder by double-clicking on its icon.

2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.,




3. Select MUSIC DEVICE from the Options menu.

4. Select your synthesizer (or ATARI ST INTERNAL SOUND) by clicking on the
appropriate button, and click on OK.

5. Select INSTALL GAME from the File menu. This will replace the RESOURCE.CFG
file on your disk. '
Please note: It is important to turn on your synthesizer before starting the game.
AMIGA
INSTALLING THE GAME
NOTE: RENAME your copies of all game disks to remove the words ‘COPY OF” from

the disk name. If the words ‘COPY OF” are not removed from the disk names of ALL the
copies, the system will continue to ask for the original disk, and will not run the game,

1. Boot your system with WorkBench, and insert Disk | of your Sierra game.
2. double-click on the disk icon, then double-click on the INSTALL icon.

3. Follow the onscreen prompts, choosing your selection with the mouse by clicking
once on the item.

4. You will be asked if you wish to install the game on your hard disk. If you do nor wish
the game to be installed on your hard disk, select NO. If you want to install the game on
your hard disk, select YES.

5. Using your mouse, select which hard drive you wish to install the game onto.

6. Follow the onscreen prompts to complete the installation.

LOADING INSTRUCTIONS

From Floppy Diskettes:

1. If you have less than 1 megabyte of memory for your Amiga, turn your system off and
disconnect any external drives.

2. Insert Disk 1 into drive DFO0:

3. Turn on your system.

From Hard Disk:
1. Load WorkBench and double-click on your hard disk icon.



2. Double-click on the SIERRA GAMES drawer.
3. Click on the drawer for the desired Sierra game.

4. Click on the game icon.

ALL SYSTEMS

PLAYING THE GAME
MOVING YOUR CHARACTER

You may move your character on the screen with the [Arrow] keys, the numeric keypad, or the
mouse. To halt your character’s steps with the keypad, press the number 5, or press the last
used direction key again. Do not attempt to move the character by holding down the
direction key. This will cause the character to start and stop continuously, resulting in
very slow progress.

Using the mouse, position the arrow to where you want the character to move, then click the
left mouse button.

NW
N \
&
d/G /2
s
4 Stop

GAME SPEED CONTROL

At times it may be useful to slow down the speed of the game animation in order to negotiate a
tricky section, or observe something more carefully. In The Colonel’s Bequest, speed is
controlled by the [+] and [-] keys, or by selecting a choice from the Speed menu, using the
mouse or [Arrow] keys.

MENUS

The Menu Bar in The Colonel’ s Bequest is not visible during play. When you press [ESC], the
Menu Bar will appear at the top of your screen with several menus which can be opened to
show the command choices available to you.

KEYS TO USE IN THE MENUS

Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow] keys to
highlight items within a menu. Press [ENTER] to select a highlighted command. Press [ESC]
to return to the game without choosing a command.



SHORT CUTS FOR COMMON COMMANDS

You can vuse function and control keys to short cut many common commands,

[F1] Help

[F2] Toggle sound on/off

[F3], [Spacebar] Repeat previous command
[F5] Save Game

[F7] Re.s;tb.re (saved) Game

[F9] Restart Game (from beginning)
[Tab] Inventory

[ESC] Show Menu Bar, Pause Game
[Ctrl-C) Cancel typed command line
[Ctrl-I] Inventory

[Ctrl-P] Pause Game

[Ctrl-Q] Quit G__ame

[+] Increase Speed

[-] Decrease Speed

[=] Ndrmal Speed

[Ctrl-V] Change Volume
[Shift-Click] Look at an object (see below)

SHIFT-CLICK

SHIFT-CLICK is a feature which will allow you to look at a person, place or object using your
mouse. Place the mouse arrow on the desired person, place or object, then hold down the

| Shift] key and press the mouse button. You will now receive a descriptive message.

* Please note: Multi-button mouse users should use the RIGHT mouse button and need not
press [Shift].

USING YOUR TAB KEY

While playing Sierra games, your [Tab] key will perform two major functions. You will use it
to review the items in your inventory, and also (if you're not using a mouse) to select options
from certain menus. The following menus will require the use of the [Tab]| key for highlighting
menu options:

MENU CHOOSE FROM
1. Opening Yes, No
2. Restart Game Restart, Continue




3. Quit Game Quit, Continue

4. Save Game Save, Change Directory Cancel, Replace
5. Restore Game Restore, Cancel, Change Directory
6. Death Window Restore, Restart, Quit

USING THE MOUSE (optional)

Your mouse will be useful to you in moving your character, and in learning about your
surroundings. To move your character using the mouse, position the arrow to where you want
the character to move, then click the mouse button. If your mouse has more than one button,
use the left button.

EXAMPLES OF COMMON COMMANDS

Many characters in the game will have information of one kind or another for you. To talk
with a character, type: talk to [character], ask (or tell) [character] about [character or object].
For example: talk to gertie, tell the colonel about lillian or ask lillian about the [object]. Try
different approaches. ‘Show’ an object to someone, and they may give you valuable
information. ‘Asking’ a character about something may evoke a different response than
‘telling’ them.

You may encounter objects you need along the way. To take an object, type: take (or get) the
[object] for example: take the note, or get the key.

Pay close attention to details. To look closely at objects, type look at the [object], for example:
look at the table. You can also use the [Shift-Click] feature described on Page 7.

You will need to use the objects you acquire as you explore. You can try different things such
as typing: use the [object], or give the [object] to [character] or show [object] to [character].
Ditferent approaches to a puzzle may bring abourt a different outcome.

RETYPING COMMANDS

If you wish to repeat a command, select RETYPE from the Action menu or press the
[Spacebar] or [F3].

INVENTORY

If you wish to see the items you are carrying, select INVENTORY from the Action menu, or
press [Ctrl-I] or [Tab]. A list of the items you are carrying will be displayed. To view an
object, click on its name with the mouse, or use the [Arrow] keys to highlight the name and
press [ENTER]. Press [ENTER] again, select OK or press [ESC] to resume play.

PAUSING YOUR GAME

If you wish to pause the game, select PAUSE from the Action menu, or press [Ctrl-P] or
[ESC]. Press [ESC] or [ENTER] to resume play.




SAVING YOUR GAME

If you wish to save your game, select SAVE from the File menu or press [F5]. To allow for
errors in judgement and creative exploration, we recommend that you frequently save your
game in progress, and that you save several different games from different points as you play.
You will always want to save your game before encountering potentially dangerous situations.
You should also save your game after you have made significant progress.

PLEASE NOTE: If you’re playing from floppy disks, you must have a separate
formatted disk ready before you can save a game. We also recommend that you create
several directories or folders on your save game disk in order to assure adequate space
for save game storage.

If you choose to save games to your hard disk, we suggest that vou create one or more save
game directories or folders on your hard disk. See your computer’s instructions for creating
directories or folders.

You may name your saved games using standard English phrases. For example, if you are
standing on a sandy beach, you might call your game standing on a sandy beach, or simply
beach.

RESTORING YOUR GAME

Select RESTORE from the File menu, or press [F7]. You will be prompted to select the game
you wish to restore. (On a single drive system, you will be prompted to insert your save game
disk). Highlight the desired game and select RESTORE. If the game you wish to restore is in a
ditferent directory, select CHANGE DIRECTORY.

QUITTING YOUR GAME
If you wish to stop playing, select QUIT from the File menu, or press [Ctrl-Q].

RESTARTING YOUR GAME
If you wish to restart your game at any time during play, select RESTART from the file menu,
or press the [F9] key. The game will begin again in the guest room shared by Lillian and Laura.

INTERACTING WITH THE COLONEL’S BEQUEST

You can generally interact with the game by typing simple commands consisting of as little as
a noun and a verb. For instance, the command get into the car can be shortened to get in car.
Unless otherwise instructed, follow all commands with [ENTER].

The Colonel’s Bequest will understand many common verbs. Here are some you might try:

LOOK CLIMB OPEN STAND
GET PUSH CLOSE GIVE
READ PLAY PULL EXAMINE
LOAD TELL SHOOT JUMP
TALK USE MOVE TAKE
PRY ASK SHOW -
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A message window will appear each time you enter a command, and at other times during the
game. When you have read the message, press [ENTER] to remove the window and resume

play.

TAKE NOTES as you discover clues and information. Record anything you think might be
important. Make a note of each area you visit, and include information about objects found
there, and dangerous areas nearby.

DRAW A MAP as you progress through the game. If you miss an area, you may miss an
important clue!

WATCH THE CLOCK. As you progress through the game, a clock will periodically appear
on your screen. Take note of the event and location when this occurs. This will help you to
keep track of your progress.

LOOK EVERYWHERE. When you enter a room for the first time, you will receive a
message on your screen describing the room. When you visit the room again you will need to
type: look around or look room to get the description. Look closely at all objects you
encounter.

EXPLORE each area of the game very carefully, and be on the lookout for clues and hidden
places. Search every area of the mansion and the grounds surrounding it. Re-visit an area
frequently, and make note of anything that has changed. Something may occur in an area while
you are elsewhere.

TALK to everyone you meet, but use discretion! Some characters will be friendly and helpful;
they may give you valuable information and advice. Others may mislead you. Try various
approaches in dealing with others. If talking to them or asking them questions yields few or no
results, show them something interesting you have found. They may have a comment that will
help you.

LISTEN closely to conversations. Useful information will pass between the other characters,
and you’ll want to pay attention to details that may help you with your investigation.

PICK UP anything that isn’t nailed down. You will come across a number of objects that may
be of use to you later. You can see an inventory of items on hand by pressing the [TAB] key at
any time.

USE the items you have picked up to solve problems in the game, or to help you to make
progress and discover more clues.

BE CAREFUL, and remain alert at all times - disaster may strike in the most unlikely of
places.

SAVE YOUR GAME OFTEN, especially when you are about to try something new or
potentially dangerous. This way, if the worst should happen, you won’t have to start all over
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again from the beginning. It is probably best to save at least one game in each act of The
Colonel’ s Bequest, s0 you will be able to return to a desired point in the game. In effect, this
will enable you to travel backward through time and do things differently if you wish. After
you have restored a saved game, take note of the time of night. Refer to your notes; you will
need to repeat some actions to insure that other events will take place as they should.

DON’T GET DISCOURAGED. If you come to an obstacle that seems insurmountable, don’t
despair. Spend some time exploring another area, and come back later. Every problem in the
game has at least one solution, and some have more than one. Sometimes solving a problem
one way will make it harder to solve the next, and sometimes it will make it easier. If you get
stuck, you might try restoring a saved game from an earlier point, then choosing a different
path. If all else fails, you can buy The Colonel’s Bequest hint book from the dealer who sold
you the game, or you can order directly from Sierra On-Line by calling (800) 326-6654.

BRING ALONG SOME HELP. You might find it helpful (and fun) to play the game with a
friend. I'wo (or more) heads are better than one at interpreting clues and solving problems,

NEED A HINT?
If you find yourself *a little stuck’ while playing a Sierra game, try the following ideas:
1. If you have a modem, you can talk to the Sierra Bulletin Board through the following
number:
(209) 683-4463
Our settings are 300, 1200 or 2400 Baud; 8 Data; N Parity; 1 Stop Bit. Our sysop will be
happy to help you.

2. Many other bulletin boards also provide hints to many of our games.
A. Compuserve: Go into the Gamers Forum (GO GAMERS) or write E-Mail to
76004,2143.
B. Prodigy: Write E-Mail to ‘HTWS90E’, or go to the PC Club and enter the
adventure games forum (Jumpword: PC CLUB).
C. PCLink: Select PCLink Plus, enter Publisher’s Connection, select Publishers
Forums, then Sierra On-Line. E-Mail may be written to the User ID ‘Sierra On Li’.
D. AppleLink: Select the KEYWORD option from the ‘Goto’ menu, and type:
Sierra. E-Mail may also be written to the User ID ‘Sierras’.
E. GEnie: From the main menu select 10 (Games), then select 1 (Games Round
Table). Select | (Games Bulletin Board), and type set 22 at the *?” prompt. This
will take you into the Sierra On-Line area.

For more information on these BBS lines, you can call these toll-free numbers:

1. Compuserve (800) 848-8199
2. Prodigy (800) 822-6922
3. PCLink (800) 458-8532

11




4. AppleLink (800) 227-6364

5. GEnie (800) 638-9636
For more information on the Sierra BBS, call:(209) 683-8989

3. The magazine Questbuster's Journal is a helpful source of many game hints.

4. Your local software dealer may carry our hint books, or may be willing to order them
for you.

5. If you are unable to obtain a hint book through a dealer, you can crder one directly
from us. Call (800) 326-6654 to place your order with a Visa, MasterCard or American
Express card, or write Sierra On-Line Inc., Order Department, P.O. Box 485,
Coarsegold, CA 93614,

6. If the hint book is not yet available for the game you are playing, call our automated
hint line at (900) 370-KLUE to receive a hint. NOTE: California residents, please dial
(900) 370-5113.

THIS SERVICE IS AVAILABLE 24 HOURS A DAY. THE CHARGES ARE: 75
CENTS FOR THE FIRST MINUTE AND 50 CENTS FOR EACH ADDITIONAL
MINUTE. IF YOU ARE UNDER 18 YEARS OF AGE, YOU MUST HAVE A
PARENTS PERMISSION TO CALL . THE CONTENTS OF ALL MESSAGES
ARE SOLELY THE RESPONSIBILITY OF SIERRA ON-LINE. HINTS WILL
NOT BE GIVEN ON OTHER SIERRA TELEPHONE LINES.

WALKTHROUGH
Please note: In order to understand the object of The Colonel’s Bequest, it is very important
that you view the opening cartoon at least once,
HOW TO USE THE WALKTHROUGH. Onscreen movement: north = up; south = down;
west = left; east = right. The walkthrough takes you through several game screens. Move your
character around the screens to the suggested places, and type in the words that appear in bold
type.
WARNING: The following information is for beginning adventurers only. The contents
include answers to some game puzzles and hints that experienced adventurers may not wish to
see. Continue reading only if you are having difficulty getting started with The Colonel’s
Bequest.
As the opening cartoon ends, we find Laura and Lillian in their shared guest room. When
Lillian excuses herself and exits the room, you will have control of the game. The most
important thing to do at this point is to examine your surroundings.
Walk north to the fireplace. Notice the portrait of the Colonel above the manitle.
Type: look at the portrait [ENTER]
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Type: look at the bed [ENTER]

After you read the response, walk south and east to stand in front of the northern-most bed.
There 1s a suitcase on the bed.

Press the [TAB] key.

Type: open the suitcase [ENTER]

Read the description of its contents.

Press the [TAB] key.

Walk thru the door on the east wall and enter Ethel’s guest room.
Type: look at the shelves [ENTER]

Type: look at the doll house [ENTER]

Type: take the bear [ENTER]

Walk north and stand near Ethel.

Type: talk to ethel [ENTER]

Type: ask ethel about lillian [ENTER]

Exit Ethel’s room through the door on the west wall, and enter your guest room.
Exit through the west door and enter the hallway.
Type: look at the marble statue [ENTER]
Type: look at the armoire [ENTER]

Type: look in the armoire [ENTER]

Walk north and enter the bathroom.

Type: look at lillian [ENTER]

Type: look at the tub [ENTER]

Walk to the sink.

Type: wash hands [ENTER]

Exit the bathroom, and re-enter the hallway.
Continue west across the hallway.

North of the armoire is a door on the west wall. Go through the door and enter the Colonel’s
room. '

Type: look at the elevator [ENTER]
Type: open the elevator gate [ENTER]
Type: look at the fireplace [ENTER]
Type: look at fifi [ENTER]
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Type: look at the colonel [ENTER]

Stand near the Colonel.

Type: tell the colonel about lillian [ENTER]

After he responds, exit the room to the east, and re-enter the hallway.

This might be a good time to save your game. See ‘Saving your Game’ for instructions.
Walk south and you will see a bannister with several dowels missing from an area on the left.
Stand up against the damaged area.

After you fall to your death, restore your game and continue exploring the estate...but be
careful!

PROBLEM DISK?
TECHNICAL HELP (MS DOS ONLY)

}ff ylou are having problems with a game disk, try these suggestions before assuming the disk is
aulty:

If you receive any of the following messages:

1) ‘Insert Disk (#)” when you have already inserted that diskette, or have installed the
game on your hard disk

2) ‘Out of Handles’ or *Out of Heap’, or if the game locks up at any point

3) ‘Disk Error’
You may have memory resident programs loaded into your RAM memory. You will need to

boot your system from a diskette containing your operating system only. Follow these
instructions to create a ‘Sierra Boot Disk’.

Format a blank disk with DOS system files (using /s) to make a bootable disk.

FORMATTING FROM A HARD DRIVE
A) Place a blank disk in drive a:

B) At the C prompt, type: format a:/s
NOTE: If your A: drive is a high density drive and you are using double density disks, you will
need to type: format a:/4/s (for 5.25" disks)or type: format a:/n:9/s (for 3.5" disks)
FORMATTING FROM A DISKETTE DRIVE

A) Place your original DOS disk in drive A.

B) At the A: pr()m](:-)t, tﬂ}e: format a:/s (be sure to switch to a blank disk when
prompted by the FORMAT program.)

NOTE: If your A: drive is a high density drive and you are using double density disks, you will
need to type: format a:/d/s (for 5.25" disks)or type: format a:/n:9/s (for 3.5" disks)
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C) Press [ENTER]

D) Respond to DOS prompts.

Now you should create a CONFIG.SYS file on your Sierra Boot Disk, with a files=20
statement. Follow these instructions to create this file:

A) Type: a:[ENTER]
B) Type: copy con config.sys[ENTER]
C) Type: files=20 ENTER]

D) Press [FO][ENTER]

You should see the message: ‘1 File(s) copied’. You will now have to re-boot your computer
F\(J:ithl );;)luanei\']u Sierra Boot Disk in the drive. Turn your computer off then on, or press
trl-Alt-Del].

If this does not clear the above messages, call (209) 683-8989 for technical help. Our technical
staff will be happy to help you.
TECHNICAL HELP (ALL SYSTEMS)

Technical assistance is only a telephone call away. Call (209) 683-8989 for convenient,

person-to-person service, or if you prefer, you may request assistance by mail. If you choose to
write to us with your request, please state your computer type and the nature of your problem.

If you find that you need to send for replacement diskettes, send the original disk 1 in the size
you need (3.5" or 5.25") to:

Sierra On-Line
P.O. Box 485
Coarsegold, CA 93614
Attention: RETURNS

?% sure to include a note stating your computer type, and the size of diskette you need (5.25" or
S

We will gladly replace your program free of charge for the first 90 days of ownership
(gleasc enclose a copy of your dated sales receipt with your requestg. After 90 days
t :

ere is a $5.00 charge for 5.25" diskettes, and a $10.08charge for 3.5" diskettes.
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‘___DO norpntg?éﬁ LLEGﬂLE
"“ COPIES OF THIS SOFTWARE ""

The software you are using was produced through the efforts of
many people. desigrers. arlists. programmers. disinbutors. retaiers
and otner dedicated workers

Tne costs of develooing ths and other software programs are
recovered through sofiware sales. The unauthorized duplication of
personal computer software raises the cost to all legitimate users

Thiz software = protected by faderal copyright law. Cooying
sottware for any reascn other than to make 2 backup & a violation of
law. Individuals who make unauthorized copes of soflware may be
subject to civil and criminal penalties.

E)SIERRA

as a membosr of the Software Publishers Asscoation (SPA) supports the ndustig's
eliort to fight the llegal copying of personal computer soltware

Report copyright viclations to:
SPFI. N0 Connecticut Avenue, NW, Sulte 901
Washington, DC 20036

Limited Warranty Notice
Sierra On- Line, Inc. wants your continued business. If you fill out the
enclosed product registration card and return it to us , you are covered by our
warranty, If your software should fail within 90 days of purchase, return it to
your dealer of directly to us. and we will replace it free. After 90 days,
enclose $5 fir 5.25" disks (or $ 10 for 3.5s" disks) and return the software
directly to us. Sorry, without the registration card you are not covered by the
warranty. This warranty gives you specific legal rights which vary from state
to state.

_ Copyright Notice

~ This manual, and the software described in this manual, are copyrighted. All
rights are reserved. No part of this manual or the described software may be
copied, reproduced, translated, or reduced to any electronic medium or
machine-readable form without prior written consent of Sierra On-Line, Inc.,
P.O. Box 485, Coarsegold, CA 93614,
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